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About this guide 

Purpose and scope 

This guide helps you get started generating Health Star Ratings (HSR) information for 
your food products with FoodWorks 10 Nutrition Labelling.  

You can use either FoodWorks® Nutrition Labelling Edition or FoodWorks® 
Premium Edition for nutrition labelling tasks. 

 

 

This guide assumes that you already have a basic working knowledge of FoodWorks. 
To learn the basics of nutrition labelling with FoodWorks, refer to the companion 
guide: Introduction to Nutrition Labelling with FoodWorks. 

Note that this guide does not advise you on how to comply with the Australian 
legislative requirements for HSR. It assumes that you understand the relevant 
legislative requirements for labelling your products, including (but not restricted to): 

• Guide for Industry to the Health Star Rating Calculator (February 2018) – how HSRs 
are calculated 

• Health Star Rating system Style Guide (December 2017) – guidance for the 
application of the Health Star Rating system on food packages 

• The Australia New Zealand Food Standards Code.  

To meet these requirements, you need to use your own skill and expertise and, where 
necessary, seek technical and legal advice. 

Role of FoodWorks  

The Food Standards Code requires that you are able to substantiate any nutrient 
content and health claims made about a food product.  

FoodWorks is an ideal tool to calculate labelling information, including Health Star 
Ratings. However, based on your own expertise and judgement you may decide to 
supplement these calculations with verification via laboratory analyses.  

Considerations include: the reliability of supplier and ingredient information, the level 
of transformation of the ingredients in the final product, the amount of processing 
involved, the complexity of the product, the level of the claim being made, and 
comparisons with competitors.  

Disclaimer 

Your use of FoodWorks to produce labelling information does not automatically mean 
that you have met your legal obligations and complied with Australian regulations.  

https://support.xyris.com.au/hc/en-us/articles/205197595-Introductory-Guide-FoodWorks-Nutrition-Labelling
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/Content/style-guide
http://www.foodstandards.gov.au/code/Pages/default.aspx
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Xyris Software disclaims any liability for any loss or injury sustained directly or 
indirectly by any person or organisation as a result of any reliance upon this guide 
and/or the FoodWorks software. You should expertly review any information that you 
gain from FoodWorks, or that you produce using FoodWorks, and seek independent 
legal advice in relation to queries that you have regarding obligations under food 
labelling laws and regulations. 

Getting more help with using FoodWorks  

▪ On-line help 

To get help on using FoodWorks: On the FoodWorks Help menu, click Help 
Topics.  

• FoodWorks support site 

To search our knowledge base and to submit support requests, please go to the 
FoodWorks support site: support.xyris.com.au 

Contact details  

Telephone:  

+617 3223 5300 or 1800 875 549 

Email:  

info@xyris.com.au 

Web:  

www.xyris.com.au 

support.xyris.com.au 

 

https://support.xyris.com.au/hc/en-us
mailto:info@xyris.com.au
http://www.xyris.com.au/
http://foodworks.zendesk.com/
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1. Health Star Ratings in FoodWorks 

Welcome to FoodWorks 10 Nutrition Labelling with Health Star Ratings (HSR). 
FoodWorks 10 enables you to generate Health Star Ratings for your products that 
comply with Australian regulations. 

FoodWorks calculates the Health Star Ratings from the products’ ingredients, and 
provides appropriate Health Star System graphics for their labels.  

About Health Star Ratings  

The Health Star Rating is a voluntary front-of-pack labelling system that rates the 
overall nutritional profile of a packaged food and assigns it a rating from ½ a star to 5 
stars. As a useful rule of thumb, if the food product carries a NIP, the use of the HSR 
system should be considered. 

Health Star Ratings are based on a point system that awards a star rating based on the 
quantity of specific food components within the product. The rating of your product 
depends on:  

• Baseline points: The following nutrients/components are used to establish the 
baseline points: energy, saturated fat, total sugars and sodium.  

• Modifying points: The following nutrients/components are used to calculate the 
modifying points:  

o FVNL (fruits, vegetables, nuts and legumes) (V points)  

o Concentrated FV (concentrated fruit and vegetables) (V points)  

o Protein (P points)  

o Fibre (F points)  

• Final points: The final points are baseline points minus modifying points. 

• HSR Category: The final star rating is calculated using the final points and the 
category of the food product. Most foods (if non-dairy, not a beverage, and not an 
oil or spread) are category 2.  

For more information, refer to the Health Star Rating System website and specifically: 

• Guide for Industry to the Health Star Rating Calculator (February 2018) – how HSRs 
are calculated 

• Health Star Rating system Style Guide (December 2017) – guidance for the 
application of the Health Star Rating system on food packages 

• Australia New Zealand Food Standards Code 

®® 

http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/Content/home
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/Content/style-guide
http://www.foodstandards.gov.au/code/Pages/default.aspx
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2. Getting started  

In FoodWorks, your products are usually referred to as recipes. So in the rest of this 
guide we’ll use the term recipes.  

Set up your database for Health Star Ratings  

If you have created a new database with FoodWorks 10 Nutrition Labelling, this 
database is automatically configured for Health Star Ratings and there is nothing more 
to do. You can skip to Chapter 3. Setting up your raw materials. 

When you open an existing database in FoodWorks 10 (created using an earlier 
version of FoodWorks) for the first time you are prompted as shown below:  

  

If you choose Yes to update, then you will get this message: 

 

If you choose Yes, then your database will automatically be configured for Health Star 
Ratings and there is nothing more to do. You can skip to Chapter 3. Setting up your raw 
materials. 

However, if you click No, and want to enable Health Star Ratings later, then you can 
follow the steps below. 

Enabling Health Star  Ratings for your database  

If you have upgraded to FoodWorks 10 Nutrition Labelling, and not yet enabled HSR, 
here’s how. 
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Step 1  –  Enable the HSR  components  

To enable the HSR components for your database: 

1. On the File menu, click Database Properties. 

2. Click Nutrients & Components. 

3. On the left, click Health Star Rating (HSR). 

4. On the right, under Health Star Rating (HSR), select Health Star Rating (HSR), 
FVNL and Concentrated FV.  

 

5. Fibre is one of the nutrients used to calculate HSRs.  Scroll down and ensure that  
Dietary fibre is also enabled. 

6. Click OK. 

Step 2 –  D isp lay  the HSR statement on  prev iew labe l s   

To display the HSR System graphic on your preview labels for this database: 

1. Open the Label window: On the FoodWorks toolbar, click the Label button. 

 

2. At the bottom of the Label window, click the Label Options button. 
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3. On the left, click Health Star Ratings. Ensure that the Show Health Star Rating 
check box is selected.  

 

Next step  

The HSR calculation is based on energy, protein, saturated fat, sugar, fibre and 
fruit/vegetable/nut/legume (FVNL and cFV) percent. When you set up your raw 
materials for HSR you need to provide their percentage FVNL and cFV. See Chapter 3, 
Setting up your raw materials. 
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3. Setting up your raw materials 

For each raw material you need to provide the following components: 

• %FVNL 

• %Concentrated FV 

For definitions and how to determine FVNL and concentrated FV for your ingredients, 
see Step 4 of the Guide for Industry. FoodWorks will use these components to calculate 
the V points for your recipes.  

There are two ways for you to set these values for raw materials: 

• Open each individual raw material and set the values in the Nutrients & 
Components tab.  

• Use the FVNL Editor to set the values for all your raw materials at once.  

Both ways are described below. 

NOTES: V, P and F points 

If an ingredient is a mix of FVNL and concentrated FV, FoodWorks automatically 
calculates the total FVNL. 

You do not need to provide points for protein (P points) and fibre (F points). 
FoodWorks calculates these values automatically and applies them to the 
baseline points as required. 

  

http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
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Set the HSR components for a raw material  

To set the HSR components for an individual raw material: 

1. In FoodWorks, open the raw material. 

2. Click the Nutrients & Components tab.  

 

3. In the Override column, enter a value for the FVNL and Concentrated FV for this 
ingredient.  

4. On the toolbar, click Save. 

TIP: Entering HSR components for all ingredients in a particular recipe 

Here’s a convenient way to enter the HSR information for all the ingredients of a 
particular recipe: 

On the View menu, click Food/Ingredient Tree.  

 

The Food/Ingredient Tree window expands any sub-recipes within the recipe, 
so all the ingredients are shown in one place.  

  

From here, you can double-click on each ingredient to open it. 
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Use the FVNL Editor for multiple raw materials  

To make it easier to enter or edit HSR components for your raw materials in bulk, the 
FVNL Editor shows all the raw materials in your database in one table: 

 

To use the FVNL Editor: 

1. On the Tools menu, click FVNL Editor. 

In the FVNL Editor, all your raw materials are listed in alphabetical order. 

2. Enter the values for FVNL and concentrated FV as required. 

NOTE – Keyboard Shortcuts:  

Note that you can use keyboard shortcuts to make it quicker to enter the 
percentage of FVNL and concentrated FV:  

    For 100%, type a.   

    For 0%, type z.  

3. Click Save at the bottom of the window. 

Next step  

Next you will set the HSR category for your recipe and check that all the HSR nutrients 
are calculating correctly. 

See Chapter 4,  Finalising the HSR for a recipe. 



GETTING STARTED WITH COOL IN FOODWORKS® 9 NL 10 

4. Finalising the HSR for a recipe  

FoodWorks calculates the HSR for your recipe from its raw materials and from the HSR 
category to which you assign the recipe. 

You can review the final HSR for a recipe in the Analysis Pane. If you need to dive 
deeper to examine how the final percentage was calculated, use the HSR Explorer. 

Set the HSR category for the recipe  

In your open recipe:  

On the General tab, from the HSR/NPSC Category drop-down, select the appropriate 
category.  

 

For definitions and how to determine the HSR category for your recipes, see Step 1 of 
the Guide for Industry. There are 6 HSR categories described in the Guide. These are the 
same categories used for nutrient profile scoring as described in the Food Standards 
Code.  

NOTE: Dairy foods 

For dairy foods, the HSR category depends on whether you can make a nutrient 
content claim for calcium. See Steps to assess the HSR of a food in the Guide for 
Industry. 

 

http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
http://www.foodstandards.gov.au/code/Pages/default.aspx
http://www.foodstandards.gov.au/code/Pages/default.aspx
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
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Check the nutrients used for HSR  

In your open recipe, you can see the calculated value for the HSR. 

 

To check that the necessary nutrients for HSRs are all calculating correctly: 

1. In the Analysis Pane, for the following nutrients/components check that there are 
no question marks (?) or greater than signs (>), and that the value appears 
reasonable:  

• Energy 

• Saturated Fat 

• Sugars 

• Sodium 

• Protein 

• Fibre 

• FVNL 

• cFV 

 

NOTE: Showing the Analysis Pane 

 If the Analysis Pane is not already displayed, on the FoodWorks toolbar, click 
the View Analyses button:  
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2. If there are question marks (?) or greater than (>) signs for these nutrients, then 
to investigate them:  

• In the Analysis Pane, click the nutrient/component with the missing value. 

• Click the Ingredients tab of the recipe. Look at the nutrient column on the right 
of the tab to check for missing values for any of the ingredients. 

• Make any necessary changes to the ingredients.  
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Use the HSR Explorer  

Use the HSR Explorer to explore in depth the HSR value calculated for a recipe. Here 
you can examine the baseline points and modifying points. 

To open the HSR Explorer: 

1. Open the recipe that you want to examine. 

2. On the View menu, click HSR Explorer. 

Here is the HSR Explorer showing some sample data.  

 

The HSR Explorer lets you see at a glance the baseline, modifying and final points, 
and the breakdown per nutrient. 

Next step  

The next chapter, Displaying the HSR on a label, explains how to display the HSR system 
graphic on your labels. 
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5. Displaying the HSR on a label 

When displaying the HSR on your label, FoodWorks provides several standard designs 
for the HSR system graphic that you can choose from. 

For guidance on the principles of the HSR system and the details of its presentation on 
food packages, see the Health Star Rating system Style Guide (December 2017). 

Show the HSR system graphic on a label  

To display the HSR system graphic on the label for the recipe, in your open recipe: 

1. On the FoodWorks toolbar, click the Label button.  

 

2. In the Label window, click the HSR tab.  

 

3. From the drop-down list, select the type of HSR system graphic you require for this 
label. 

 

Set advanced options  

You can control aspects of the content and look of your label in the Label Options 
dialog.  

For Health Star Ratings, you can control whether they are shown, and also whether you 
want to display a minimum rating for recipes with missing data (e.g. fibre values). 

NOTE: All options set through the Label Options dialog apply to all the labels 
generated in your FoodWorks database. 

http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/Content/style-guide
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To set the advanced options for HSR: 

Step 1 –  Open the Label Options window  

To set the options for Health Star Ratings: 

1. On the FoodWorks toolbar, click the Label button.  

 

2. At the bottom of the Label window, click the Label Options button.  

 

3. On the left, click Health Star Ratings.  

 

4. Select options as required. 

Next step  

The next chapter, Printing a label, explains how to print or publish your labels with 
Health Star Ratings. 
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6. Printing a label 

Now that you have your label ready, here are the options for printing or publishing this 
individual label:  

The Toolbar in the Label Window – print or publish the label: 

 

 

 

 

 
 
 
 
 
 
 

NOTE: Publishing all of your labels   
You can also publish the labelling information for all your recipes from your 
FoodWorks database for use by your label-printing software. See the next 
chapter. 

Print the label  

To print the label directly to your standard printer: 

1. On the toolbar of the Label window, click the Print icon. 

 

2. Click OK. 

NOTE: Printer set up   
On the toolbar of the Label window, click the Page Setup icon.  

 

Set properties as required and click OK.  

Page 

setup 

for 

printing. 

Open 

the label 

in MS 

Word. 

Open 

the label 

as a 

PDF. 

Print 

this 

label. 

NOTE; If you use Copy 

to clipboard the 

graphical elements are 

not included. 

NOTE; If you use the 

Publish to Excel option 

the graphical elements 

are not included. 
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Open the label in Microsoft Word  

To open the label for editing in Microsoft Word: 

1. On the toolbar of the Label window, click the Publish to Word icon. 

 

The label will be opened in Word. Note that some formatting information may be lost in 
the conversion from PDF to Word format. 

Open the label as a PDF  

To open the label as a PDF document: 

1. On the toolbar of the Label window, click the Open as PDF icon. 
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6. Publishing your HSR information 

You can publish the labelling information for all your recipes from your FoodWorks 
database to Microsoft Access or to a tab-delimited text file ready for use by your label-
printing software.  

Publish your labels via label-printing software  

To publish the labelling information from your FoodWorks database to Microsoft 
Access or to a tab-delimited text file for use by your label-printing software: 

1. Open the FoodWorks database.  

2. On the Tools menu, click Publish Labelling Information...  

 

3. Follow the instructions displayed.  

HSR information published  

When you publish your labelling data (using Publish Labelling Information on the 
Tools menu), FoodWorks includes information to support HSR.  

The HSR columns published are as follows:  

• HSRStars – number of stars in numeric value 

• HSRStyle – numeric value from 0 to 4 

o 0 = No HSR 

o 1 = HSR only 

o 2 = HSR + Energy 

o 3 = Energy only 

o 4 = HSR + Energy + 3 Nutrients 
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• HSRImage – This value corresponds to the Health Star Rating image name in the 
HSR Assets folder of the FoodWorks®-BarTender® resources. You can download 
the FoodWorks-BarTender resources here on the FoodWorks support site.  

• HSRUnits – numeric value, 0 or 1 

o 0 = per 100g 

o 1 = per 100ml 

• HSRUnitsStatement – ‘per 100g’ or ‘per 100ml’ in text 

• HSREnergy – energy value and unit in text 

• HSRSaturatedFat – saturated fat value and unit in text 

• HSRSugars – sugars value and unit in text 

• HSRSodium – sodium alue and unit in text 

Get the HSR system graphics into BarTender  

If you are publishing your labelling information from FoodWorks for use in the BarTender® 
Label Software, we provide a solution that enables you to include the HSR system graphic. 

You can find more information here on the FoodWorks support site.  

 

 

https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-
https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-

